# Table of Contents

**THE MYELOMA MANAGER PERSONAL CARE ASSISTANT™**  

**INSTALLING THE MYELOMA MANAGER™**

**GETTING STARTED**

- Launching the program ................................................................. 9
- Using The Help Function ............................................................... 9
- Setting Up The Laboratory Tests You Will Track ......................... 10
- The Quick Start Function ............................................................ 11
- Changing The Order Of Tests ..................................................... 11
- Removing Or Adding Tests To Track .......................................... 13
- Entering Your First Results ......................................................... 14
- Drawing Graphs And Printing Reports .................................... 15

**HOME TAB**

- Current Lab Results ................................................................. 16
- News ......................................................................................... 17
- Upcoming Appointments And Tasks ....................................... 18

**RESULTS TAB**

- Results Grid ............................................................................. 19
- Limiting Range Of Results Displayed ...................................... 20
- Printing A Full Historical Report ........................................... 20
- Editing Previously Entered Results ....................................... 22
- Adding results for a new date ................................................ 24
- Limiting Range Of Results Displayed ...................................... 25
- Keeping Track Of Multiple Result Sets .................................. 26
**GRAPH TAB**

Expanding and Collapsing Test Groups ................................................................. 27
Changing Graph Type ............................................................................................ 28
Limiting Results Appearing On A Graph ............................................................ 29
Previewing And Printing Your Graph .................................................................. 30
Saving Your Graph ............................................................................................... 31
Adding captions to a graph.................................................................................. 31
Time Scaled Graphs .............................................................................................. 33
Plotting Multiple Tests On One Graph ............................................................... 34

**CALENDAR TAB**

Creating A New Appointment............................................................................... 36
Creating A New Task............................................................................................ 37
Recurring (Repeating) Appointments And Tasks .............................................. 38
Using Subtasks Represent Complex Treatment Regimens .............................. 40
Using the Task Palette......................................................................................... 42
Linking Items To Appointments ........................................................................ 45

**CONTACTS TAB**

Adding A New Contact ....................................................................................... 46
Finding A Contact............................................................................................... 47
Viewing/Editing An Existing Contact............................................................... 48
Linking Items To Contacts ................................................................................ 48
Viewing Links To A Contact ............................................................................. 48

**NOTES TAB**

Creating A New Note ......................................................................................... 50
Editing Your Notes.............................................................................................. 51

**INFO TAB**

IMF News ........................................................................................................... 52
Reference Shelf................................................................................................... 53
Adding Website Links or Files To The Reference Shelf .................................... 53
Making changes to the Reference Shelf ............................................................. 54
The Myeloma Manager™ Personal Care Assistant™

Welcome to the Myeloma Manager™ Personal Care Assistant™. We are pleased to be able to introduce this software, designed specifically for patients and caregivers battling multiple myeloma. We hope that you will find it useful. As this software is very new and is really the first product of its kind, we very much look forward to your feedback and suggestions. You can help us identify problems that we need to fix as well as understand what we can do to make the software more valuable for myeloma patients and caregivers.

The Myeloma Manager™ was developed by the International Myeloma Foundation (IMF) to help patients and caregivers deal with the growing glut of information and constantly increasing complexity of myeloma treatment programs. The Myeloma Manager™ is a program that runs on the user’s computer and stores all personal data on the user’s computer. None of the user’s data is transmitted to anyone. Access to the Myeloma Manager™ is password protected and the data is encrypted (scrambled) so that it cannot be accessed from outside of the Myeloma Manager™.

At its core, the Myeloma Manager™ provides a tool to capture laboratory results and display and print tables and charts to show how those results change over time. The software also includes real-time news feeds from the IMF web site and a reference shelf, with links to useful publications and web pages.

Currently under development and slated for a future release are calendar, contacts and notes features. These will allow users to put their doctor’s appointments and treatment regimens on a calendar. Contacts will allow for storage of important phone numbers and addresses. Notes will allow you to create a journal of past events as well as make notes about things that need to be done in the future. Integrated scanning functions will allow for scanning of medical reports directly into the tool as attachments to an appointment, contact or note. Users will also be able to attach other documents (PDFs, spreadsheets, etc.) to appointments, contacts or notes.

Slated for future development is a process to manage medical bills and insurance claims/reimbursements. But, this process has yet to be designed and we are now totally focused on bringing the functions we’ve designed to fruition and then making the tool available to the public. Once we’ve gotten the software deployed and proven, we can then expand the scope of the software and build new features and functions.

As one of our early users, you will play an important role in helping us refine and enhance this software so that it can be most useful to patients and caregivers. We thank you for your help and hope you enjoy being a part of this exciting project!
Installing the Myeloma Manager™

The Myeloma Manager software can be downloaded from the IMF website. You can access this site by typing the following address into your web browser:

http://manager.myeloma.org

This will take you to the Myeloma Manager™ webpage.

The software is provided free of charge by the IMF, via the website's store. Click on the "Download the Myeloma Manager™ link. This will take you to the IMF store where you can download the software and user manual. You will need to click the "Add to Cart" button to start the process.
You will then see the Myeloma Manager in your shopping cart. Click the "Continue Checkout" button to move forward with the download process.

You then need to fill in your contact information, which we will use to inform you about software updates and issues. Then, click "Submit Order."
You should then see the "Thank You" screen which contains links to download the Myeloma Manager™.

The software is approximately 30 megabytes and should take less than 10 minutes to download on most broadband connections. Once you've downloaded the installer, double click on the file and follow the instructions given by the installer.
Getting Started

Launching the program

“You gotta be in it to win it!” You need to launch the software in order to be able to use it. It should launch automatically at the conclusion of the install process. To launch the software manually, double click on the desktop shortcut (see left) or use the Start Menu and select Myeloma manager (see right.)

After the program finishes loading, you will be on the “Home Tab.”: You will also see a floating “credits” window. If you click anywhere on the Home Tab, the credits window will disappear. You can bring this window back up by selecting “About The Myeloma Manager™ under the Help Menu.

Using The Help Function

We have included a help function with the software that provides information about how the different screens work and how to get things done. You can access Help via the Help Menu or by clicking the "Help" button on the bottom of each screen. If you press the "Help" button, the section relevant to the screen you are on will be displayed.
Pressing this button will bring up the "Help" window.

To get the most out of our Help system, you should click on the (maximize) button on the top right to expand the help window to cover the full screen. The help system includes a number of multimedia clips to illustrate how things work. These are downloaded from the internet as you view them so they will not work unless you are connected to the internet and there may be a short delay while they are downloaded.

**Setting Up The Laboratory Tests You Will Track**

When you open the Myeloma Manager™ for the first time, there will be a button on the Home Tab labeled "Begin Entering Results".

Clicking this button will bring you to the Results tab. There are two buttons on the top left to help get you started- "Select Tests To Track" and "Quick Start"
The Quick Start Function

"Quick Start" will pre-select a list of tests commonly used for myeloma with one click. You should find most of the tests you're interested in using this option.

Changing The Order Of Tests

Tests are listed in groups. In the example above, IgA, IgG and IgM appear under the group Ig Quant. You can change the order of tests within groups or the order of the groups by dragging and dropping the tests and/or groups. To drag and drop, move the mouse to the group or test, press and hold the left button, drag the mouse to the place you'd like the group or test to be, and then let go of the mouse button.

The pre-defined tests have been entered with typical ranges. However, ranges often vary from lab to lab. And, certain tests, like Hemoglobin (HGB), have different ranges for men and women. So, you should review the tests on the Results tab to check the ranges. Below the test name, the low and high ranges appear in parentheses. So, to change the range for HGB, double click on the test name:
You will be asked if you want to change the test. Click "Yes".

This will bring up the Create/Modify Tests window. Enter the desired range in the Min/Max fields on this window.

You also have the option to specify the units in which the test is reported (e.g., mg/l). The units will often appear next to the test name on the laboratory report. Different labs may report the same test using different units so this can be important.
Removing Or Adding Tests To Track

Using the Setup Tests option under the Admin menu or the "Setup Tests" button on the Results tab, you can add or remove tests from your Tests To Track list (and the Results tab).

Selecting this menu option brings up the Setup Tests window. For information about how to use this window, click on the "Help" button or see the Setting Up Tests section (page 5.)

If you are looking for a particular test, you can type all or part of the short name into the search box at the top of the Library Tests or Tracked Tests lists.
Entering Your First Results

Once you've got the tests you'd like to track selected, you can then add results. To do this, click on the "New Date" button.

This will bring up the Enter/Edit Results
Drawing Graphs And Printing Reports

To draw a graph of the results for a test, highlight any result for that test and click the "Graph" button.

This will bring up a graph for that test.

You can use the Print Lab Results option under the File Menu or the Print button on the Results tab or Graph tab to print a report with some or all of your results in tabular form and/or graphs. For more information on this function, see Printing A Full Historical Report (page 64.)
Home Tab

Current Lab Results

This area displays any test results that have had an abnormal result in the last 2 values reported.

<table>
<thead>
<tr>
<th>Current Lab Results</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>HCT</td>
<td>38.8-46.4</td>
<td>01/15</td>
<td>37.4</td>
<td>12/17</td>
<td>39.3</td>
</tr>
<tr>
<td>HGB</td>
<td>13.3-17.7</td>
<td>01/15</td>
<td>13.0</td>
<td>12/17</td>
<td>13.5</td>
</tr>
<tr>
<td>%Lymph</td>
<td>20.0%-50.0%</td>
<td>01/15</td>
<td>23.0%</td>
<td>12/17</td>
<td>15.0%</td>
</tr>
<tr>
<td>IgA</td>
<td>70-350</td>
<td>12/17</td>
<td>80</td>
<td>11.07</td>
<td>62</td>
</tr>
<tr>
<td>IgG</td>
<td>700-1700</td>
<td>12/17</td>
<td>461</td>
<td>L</td>
<td>11.07</td>
</tr>
<tr>
<td>IgM</td>
<td>50-300</td>
<td>12/17</td>
<td>21</td>
<td>L</td>
<td>11.07</td>
</tr>
<tr>
<td>Lambda FLC</td>
<td>0.6-2.5</td>
<td>01/15</td>
<td>30.0</td>
<td>12/17</td>
<td>34.0</td>
</tr>
</tbody>
</table>

For each test that had any abnormal results in the last two results reported, the following will be displayed:

- Group – Every test is assigned to a group, used to help put the tests in a logical order
- Test Name – Identifies the individual test
- Test Range – The lowest and highest values considered normal for the test
Dates and Result Values—The two most recent dates for which results were reported for that test along with the result values

Test Result Icons—For each result that is not normal, an icon will be displayed indicating the reason the result has been flagged, as explained below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>High, No Change</td>
</tr>
<tr>
<td>H</td>
<td>High, Getting Better</td>
</tr>
<tr>
<td>H</td>
<td>High, Getting Worse</td>
</tr>
<tr>
<td>L</td>
<td>Low, No Change</td>
</tr>
<tr>
<td>L</td>
<td>Low, Getting Better</td>
</tr>
<tr>
<td>L</td>
<td>Low, Getting Worse</td>
</tr>
</tbody>
</table>

News

If you are connected to the internet, this area will display a list of news items downloaded from the IMF web site. Clicking on the headlines will bring up your web browser and take you to a web page where you can read the full story. The News area has buttons $\text{A}^+$ $\text{A}^-$ to make the text bigger or smaller.

Wednesday, March 12, 2008

Myeloma in Prime Time

On "The Fine Art of Surfacing," the season finale of the series "October Road," a character played by Tom Berenger is diagnosed with myeloma. If you would like to
Upcoming Appointments And Tasks

This area contains a list of upcoming appointments, tasks and notes. For tasks and notes, there is a checkbox allowing you to mark the task(note as completed, which will remove it from the list.

By default, all items within the next fourteen days will be displayed. You can change this "look ahead" option by using the Tools Menu/Options.

This will bring up a window that will allow you to change the "look ahead" setting.
Results Tab

The Results Tab provides a spreadsheet-like view of your lab results. Using this tab, you can view, edit, print and chart previously entered results.

Results Grid

This grid provides a spreadsheet-like view of your previously entered lab results.

- Each row has a date on the left. Dates appear most recent first. So, the top row contains the most recently reported results

<table>
<thead>
<tr>
<th>Date</th>
<th>IgA (70-350)</th>
<th>IgG (700-1700)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/15/2008</td>
<td>80</td>
<td>461</td>
</tr>
<tr>
<td>12/17/2007</td>
<td>62</td>
<td>461</td>
</tr>
<tr>
<td>11/20/2007</td>
<td></td>
<td>385</td>
</tr>
<tr>
<td>10/01/2007</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Unlike a spreadsheet, the columns have two-level headings. The top most headings are the Test groups (e.g., Ig Quant to group immunoglobulin tests IgA, IgG and IgM)

- The second level heading is contains the Test Name and the normal range for that test, which appears in parentheses following the test name.
- There are buttons to make the text on the Results grid larger or smaller.
Limiting Range Of Results Displayed

If you have lots of data stored on your results grid, you may find that the Myeloma Manager™ may become sluggish, or slow to respond when you add or update results. The easy way to solve this problem is to click on the Date Range button on the Results tab.

This will bring up a window that will allow you to specify display of all dates, a specific range of dates, or a specified number of the most recent result dates.

Using this feature doesn't delete the results not shown. They can always be restored by clicking the Date Range button and selecting All.

If you use the Import function to import more than 12 result dates, the date range will automatically be set to display only the most recent 12 results.

Printing A Full Historical Report

You can use the Print button on the results tab to print your lab results. This function is also available on the File menu. When you click the Print button, you will get a fairly formidable-looking window. But, don’t panic. It’s not that complicated.
On the left are tests that are being tracked that have NOT been selected for printing. On the right are the tests selected for printing. There are two columns of checkboxes next to the tests to print. The one labeled Print Result indicates whether the result is to be printed in tabular form for that test. The Print Graph indicates whether a graph is to be drawn for the test. The checkboxes above the list of tests allow selection or de-selection of all of the tests with one click.

Using the checkboxes above the column headings, you can select or de-select all of the tests in the Tests To Print Window. Checking the Show Print Preview option will display a preview window to show you how the report will look before it is printed.

After selecting the tests to be printed/graphed, click the "Print" button. You will then see a window asking you for a footer. The footer is a message that will be printed on the bottom of each page of the report.
Pressing OK will move forward with printing the report.

## Editing Previously Entered Results

On the top of the results grid, there is a group of three buttons that provide different ways to view/edit results:

- **By Date**: If you highlight a cell in the results grid and click on the **DATE** button, this will bring up a window with all of the tests for the row (date) you clicked. The window will scroll to the test you clicked and highlight it. You can change that result or any other result for that date by scrolling to it in this window. You can also click the print button to print out all of the results for the date.

- **By Test**: If you click a result in the results grid and click the **TEST** button, you will bring up a window with all of the results in the column (Test) that you highlighted. As with the “By Date” window, you can edit any of the results. You can also use the Print button to print all of your results for the test.

![Lab Results for 11/07/2007](image_url)
• Editing one cell at a time ("Spreadsheet mode"). If you click on a result in the results grid and click the button, you can then edit results directly on the results grid. You can use the arrow keys (↑, →, ↓, ←) on the keyboard to move from cell to cell on the grid and make changes or add new results to empty cells.
Adding results for a new date

You can add new results to previously reported dates and add new dates for which you want to report results by pressing the New Date button.

This will bring up an entry window that includes all tests being tracked. You can then type in the date of the results or use the calendar popup to specify the date.

You must click the "Save" button after entering your results so that they will be stored in the Results grid.
Limiting Range Of Results Displayed

If you have lots of data stored on your results grid, you may find that the Myeloma Manager™ may become sluggish, or slow to respond when you add or update results. The easy way to solve this problem is to click on the Date Range button on the Results tab.

This will bring up a window that will allow you to specify display of all dates, a specific range of dates, or a specified number of the most recent result dates.

Using this feature doesn't delete the results not shown. They can always be restored by clicking the Date Range button and selecting All.
Keeping Track Of Multiple Result Sets

This feature was added primarily for cancer centers and other clinical facilities who use the program to track multiple patients. The Myeloma Manager™ can keep track of multiple result sets, typically used to track different patients. Result sets can be managed using the File Menu/Select Results Data option.

Clicking on "Select Result Data" brings up a dialog that allows you to create, delete, rename or select result sets.

To select a result set, click on the name of the result set and then click the select button. Once selected, only the results for that result set will be displayed/printed by the Myeloma Manager™.
Graph Tab

Graphs are generated automatically with pre-set formatting once results are entered. There is no need to use the Graph tab unless you’d like to change the appearance of the automatically-generated draft. There are many options available for customizing graph formats. Formats are specific to the test. So, you can choose different options for each test based on what is most helpful in understanding trends for that test. To change the options for the graph for a test, you need to use the Graph tab.

Expanding and Collapsing Test Groups

On the graph tab, you will see three areas. The first shows the tests being tracked. These tests are shown by group. If you see a + next to the group name, it means that the group is "collapsed", that the tests in the group are not being displayed. If you click on the "+", the tests that are part of the group will be shown and the "+" will change to a "-", meaning that the group is "expanded". If you click on the ",", the group will be "collapsed" and its tests will be hidden. If you click on the "+" button on top of the list of groups and tests, it will expand all groups. Clicking on the "-" button above the list will collapse all groups.
Changing Graph Type

Select the test from the Tracked Tests list on the left. If you either double click on the test name or highlight the test (as shown above) and click on the New Graph button, the test will appear in the Graph area on the right. If you don't specify the graph type, the system will draw a line graph.

Clicking on "Bar Graph" will change the graph from lines to bars.
Limiting Results Appearing On A Graph

Since people are living longer and longer with myeloma, many have lots and lots of lab results accumulating over time. This can make graphs look pretty crowded. So, you might want to limit the results appearing on a graph to the most recent. For example, you could specify that only the last 9 results are to be charted (see below):
Previewing And Printing Your Graph

You can see how your graph will look when printed by clicking the "Preview" button. This will bring a full page view of your graph.
Clicking on the "Print" button on this page will print a copy of the graph.

**Saving Your Graph**

If you click the "Save" button, the graph settings will be saved and the graph will appear in the Saved Graphs area.

When you save a graph for a test, the settings you've saved will be used when drawing a graph for that test. So, if you press the "Graph" button on the Results tab to view the graph or use the Print function and include a graph for that test in a report, it will appear as you've just seen it on the graph tab. So, in this case, the graph for RBC will be drawn as a bar chart and it will only include the most recent 9 results.

**Adding captions to a graph**

Captions can make your results graph more useful by noting significant events (e.g., starting a new treatment) that could affect the results.

You need to create this Text Test and enter the captions into that Text Test in the results tab so that you can use it later to place text on the graph. To do this, select "Create Test" from the Admin menu:
You will then be able to define a test, with type text, to hold your captions. You can create multiple Text Tests with different names if you want to use different captions on different graphs.

To add a caption, you must switch to the Graph tab. You then select the test to graph and the graph will appear on the right of the Graph tab.

You then need to select a Text Test that contains the caption(s) to be included on the graph and click the Add Text Button.
This test will have the captions entered on the dates you want them to appear. The caption(s) will be placed next to the results for the date(s) specified. In the example below, the Notes indicate the day that therapy was switched to Revlimid:

![Graph Image]

**Time Scaled Graphs**

If space allows, the Manager™ will allow you to use a time scale for your graph. This means that if your results are at irregular intervals, it will space them from left to right based on how far apart the results are. This option is enabled by default. It can be changed by selecting Options under the Tool menu:

![Options Menu]

You would then expand Graph Tab by clicking on the + sign and then clicking on Line Graph:

![Options Submenu]

You can then specify whether or not you want to use the time scale option by selecting Yes or No.
Plotting Multiple Tests On One Graph

You can plot multiple tests on a single graph. This is called an "overlay." To do this, go to the Graph Tab and either select a previously-saved graph or click on a test to create a new graph and then click on the Save button to save the graph. Once you have done this, your graph should appear on the right as shown below and in the Saved Graphs listing in the middle of the screen:

You can then select an additional test to appear on the same graph by highlighting the test and clicking the Overlay button.
The second test will then appear on the graph:

You can repeat this procedure to add more tests to the same graph.
Calendar Tab

The Calendar Tab provides a full function calendar to help manage appointments and tasks. It also provides special features to help you track complicated treatment regimens.

Creating A New Appointment

To add an appointment to the calendar, click on the New Appointment button on the Calendar Tab.

This brings up the appointment details window.
You need to fill in the fields on the details window and then click Save and Close:

- **Subject**: title of the appointment, will be shown on the calendar display
- **Location**: optional, the location of the appointment
- **Dates/Times**: the start and end dates/times for the appointment. The start date will default to the date that was selected on the calendar when the New Appointment button was clicked. You can enter the date or use the pop up calendar menu by clicking on the arrow on the right of the date field
- **All Day Event**: check this box if the appointment will last the entire day or if it has no specific time

You can also link contacts, notes, files or scanned documents to the appointment (see page 59.)

### Creating A New Task

Tasks are things you need to do on or by a certain date (i.e., to-do's). Examples of tasks would include:

- Scheduling a doctor's appointment or test
- Taking medications as part of a treatment regimen
- Renewing a parking permit

To create a new task, click on the new task button
This brings up the task details window. You need to fill in the fields on this window and click Save and Close.

- Subject: the name of the task (will be shown on the calendar display)
- Location: optional, location for the task
- Task Date: the date by which the task should be completed

Recurring (Repeating) Appointments And Tasks

Very often, appointments or tasks will repeat on a regular basis. For example, you may need to schedule a doctor's appointment every 3 months. You may need to take a pill once a week. Appointments and tasks can be set to automatically repeat using the recurrence feature. You can add recurrence to an appointment or task by clicking on the Recurrence Button on the task or appointment window.

This brings up the Recurrence window.
The Recurrence pattern specifies the type of repeat (i.e., daily, weekly, monthly, yearly), how long between repeats (e.g., every 2 weeks) and the day of the week for the repeat for daily and weekly repeats.

The Range of recurrence specifies the start date and end dates. Recurrences can also have no end date or be set to end after a specified number of occurrences (e.g., once every 2 weeks, repeated 10 times.)

For example, if you supposed to have an intravenous infusion twice a week on Mondays and Thursdays for 3 weeks, the recurrence would look like this:
This recurrence capability is very similar to what you will find in commercially available calendar programs. If you want to represent a more complicated but still pretty simple treatment like taking a pill four days on, four days off for an indefinite period, this model does not work. For this reason, the Myeloma Manager™ has added a feature called Subtasks to let you represent more complicated repeat patterns necessary to track treatment regimens.

Using Subtasks Represent Complex Treatment Regimens

Treatment regimens can be tough to keep straight. Even "simple" ones like taking a pill four days on, four days off for an indefinite period can be tricky to remember and beyond the standard calendar program repeat features. The Myeloma Manager™ handles them by something called Subtasks.

For example, if we wanted to represent taking that pill four days on, four days off over an indefinite period, we would first create a new task that repeats every eight days:
This will set up a cycle that repeats every 8 days. But, now, we need to put the 4 day on, 4 day off pattern in as a Subtask. You can do this by selecting the 8 day cycle on the Calendar display and clicking the New Subtask button:

You would then create a Subtask under the 8 Day Cycle Called "Take The Pill". This task would have a daily recurrence, repeating every day and ending after 4 occurrences.
Using the Task Palette

The task palette contains tasks that can be used as models for some of the most common treatment regimens. To select a model from the task palette, use the drop-down-menu:

For example, if you select Rev Cycle, this will place the model task on your calendar beginning on the current date:

<table>
<thead>
<tr>
<th>Sunday</th>
<th>Monday</th>
<th>Tuesday</th>
<th>Wednesday</th>
<th>Thursday</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 18</td>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
</tr>
<tr>
<td>5/18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5/25</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
</tr>
<tr>
<td>Jun 1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>6/1</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
</tr>
<tr>
<td>6/8</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
</tr>
<tr>
<td>6/15</td>
<td>Rev25mg</td>
<td>Rev25mg</td>
<td>CBC Test</td>
<td></td>
</tr>
</tbody>
</table>

This model is for a 28 day cycle. Treatment with Revlimid 25mg is a second level task, recurring daily for the first 21 days of the cycle. Treatment with dex 40 mg is weekly for the first three weeks of the cycle. On day 22 of the cycle, a CBC test is scheduled as well. The model includes only one cycle.
Models will typically need to be adjusted to indicate the correct start date and number of recurrences. For example, if this cycle actually began on Monday, April 19th and should have a total of four recurrences (cycles), you would double click on "Rev Cycle":

You would then click on "Recurrence" to make these changes:
Keeping Track Of Multiple Calendars

This feature was added primarily for cancer centers and other clinical facilities who use the program to track multiple patients. The Myeloma Manager™ can keep track of multiple calendars, typically used to track treatments (tasks) and appointments for different patients. Calendars are selected in the Calendars Tab using the Calendars field that appears to the left of the Calendar.

You select a Calendar for viewing by clicking on it. You can create, delete or rename Calendars by using the buttons in the Calendars field (see below):

![Calendar Example Image]

You can also change the doses indicated on the subtasks for Revlimid and Dex. For example, if you wanted to change the dex dose to 20mg, you can just double-click on any of the instances of the dex subtask on the calendar:

![Calendars Example Image]

And, then change the Subject of the subtask to indicate the correct dosage.
Linking Items To Appointments

You can link notes, contacts, files and scanned documents to appointments. For information about how to create links, see Linking.
Contacts Tab

Welcome to the Contacts Tab! The Contacts tab allows you to store contact information for people and organizations.

Adding A New Contact

To add a new contact, first click on the New Contact button:
This will bring up the Contact Details window where you can enter the relevant information.

You can also link notes, appointments, tasks, files or scanned files to contacts (see page 48.)

Finding A Contact

To find a contact, you can use the search box on the top right of the contact display. You can search by first name, last name, organization or email address. Use the menu shown below to select the search type and type all or part what you are looking for in the search box on the right.

You can also use the buttons on the left of the contact display to help find the contact you are looking for. These are the buttons starting with All, 123, A, B, C, D, etc. These buttons can be used to jump to the first contact whose last name (or organization name if there is no individual name entered) begins with the letter pressed. The All button restores the display to show all contacts. The 123 button will show contacts whose name or organization begins with a number.
Viewing/Editing An Existing Contact

You can view and edit the details of an existing contact by double-clicking on it or clicking on it once and pressing the View/Edit Contact button.

Linking Items To Contacts

You can link notes, appointments, tasks, files and scanned documents to appointments.

To create a link to a contact, select the contact you want to link to and press the link button.

Viewing Links To A Contact

You can view the links to a contact by selecting clicking on the links line in the contact:
This will bring up the links window, where you can view or delete existing links as well as set up new ones (see page 56)
Welcome to the Notes Tab! Notes allows you to create personal journal entries and also file important documents by date and subject.

Creating A New Note

To create a new Note, click on the New Note button on the Notes Tab. This brings up the Create/Modify Notes window.

You should fill in the Subject for the note as well as the Date. If the note relates to something you need to do in the future, you can give it a Due Date. This will put the Note on the Upcoming Items list on the Home Tab when its due date approaches.
You can link files, scanned documents appointments, tasks or contact to a note by clicking on the buttons along the top of the Create/Modify Notes window. For more information on how to do this, see Linking (see page 56)

**Editing Your Notes**

You can type text into your notes and also format that text as well as add pictures and hyperlinks.
Info Tab

The Info tab contains a web-feed of IMF News as well as a Reference Shelf to provide ready access to relevant information about managing your myeloma.

IMF News

This area contains a list of news items about the IMF. You can click on any of the items to bring up more information. Also note that there are buttons on the IMF News area to make the text larger or smaller.
Reference Shelf

The reference shelf provides ready access to important information. This can include website links or files stored on your computer.

Adding Website Links or Files To The Reference Shelf

You can add new webstie links to the reference shelf. These can either be websites or other web resources, such as videos or PDF documents. To add a new website link, click on the "Add New" button on the top right.

You will then be given the option of adding either a Website URL or a File. Select the appropriate option.
For a website, you need to enter the URL (address) and a name and select the folder you would like the file to appear in.

![Image of New Reference dialog for websites]

For a file, you can click the browse button to select the file you would like to include. You should also select the folder that you want the file to appear in.

![Image of New Reference dialog for files]

**Making changes to the Reference Shelf**

The Reference Shelf comes preloaded with content provided by the IMF. You can add to, change or delete any of the items on the reference shelf.
Adding and Deleting Folders from the Reference Shelf

You can also add new folders to your reference shelf. To add a new folder, click on the "New Folder" button. To remove a folder, highlight it in the New Reference window and click the "Delete Folder" button. You need to be very careful when deleting folders but it will also delete any references contained in that folder.
Linking

Linking allows you to link items to your appointments, notes, contacts, files and scanned documents. Linking items makes them easily-accessible. For example, if you link a contact to an appointment, you can easily pull up the contact with its phone number and address information from the appointment.

Also, when you link items, links are reciprocal-- meaning that if you link a contact to an appointment, the appointment is linked to the contact. So, if you don't remember when your last appointment was with a doctor, you can pull up the contact record and see all the appointments linked to that contact.

You can create links to the following types of items:

- Contacts
- Appointments
- Notes
- Files
- Hard-Copy Documents (scanned)

Linking From Appointments

You can create links from appointments using the buttons along the top of the Appointment Details window or by pressing the Links Button on the Appointment Details Window. You can bring up the Appointment Details window by double clicking on the appointment in the calendar display.
Linking From Contacts

You can create links from contacts by selecting the contact and clicking either the links button or the entry on the Links line of the contact.

Linking From Notes

You can link from notes by clicking on the Links Button or the buttons on the top left of the Create/Modify Notes window. You can bring up the Create/Modify Notes window by double clicking on the Note in the Notes Tab display.
Linking To Contacts

Click on the Link Contact button. There is a link contact button on the appointment and note windows.

This brings up the list of contacts. You can type all or part of the last name to find the contact you’d like to link. Or, you can select Company/Organization for the "Filter By" to search for all contacts with a specific company/organization.

Select the contact you want to link and click OK. The contact will now appear on the appointment window.
Linking To Appointments

There is a link appointment button as well as an option under the Link Button on the Create/Modify Notes Window.

To link to an appointment from a contact, double click on that contact's Link line. This will bring up the Contact links window, which has a Link Appointment button.
Linking To Notes

You can link to Notes by clicking on Link Notes under the Link Button or on the toolbar at the top of the View/Edit Contact window or the Appointment Details windows.

Attaching Files

You can attach files to a Note by clicking the Attach File Button on Appointments, Notes or Contacts.
Clicking on the Attach File will bring up a standard windows file dialog. You choose the file you’d like to attach and then click Open to attach the file.

Scanning Documents

You can scan documents by using the built in scanning function and then attach them to appointments, notes or contacts. As with the other types of links, there is a button (in this case Scan) on the window for the item you want to attach the scanned document to. Clicking the scan button brings up the Scan window.
The first step is to click on the Select A Source button. This will bring up a window listing the scanners installed on your system. You can use any TWAIN-compatible scanner (which is most scanners.) Highlight the scanner you would like to use and click the Select button.

You then click on the Acquire button to bring up the scanner’s control window. Each scanner’s software is different and the control window will look different depending on the vendor and model of the scanner. An example is shown below. Usually, there is a Scan button you need to push to start the scanning process.
If you have difficulty with the built-in scanning function, you can scan your documents using another program and then attach the scan file using the Attach File function.
Printing

You can print results in a number of different ways:

- Full historical reports
- Reports that have all results for a particular date or test
- Or, a graph for a particular test

Printing A Full Historical Report

You can use the Print button on the results tab to print your lab results. This function is also available on the File menu. When you click the Print button, you will get a fairly formidable-looking window. But, don’t panic. It’s not that complicated.

Please see "Limiting Range Of Results Displayed"

If you have lots of data stored on your results grid, you may find that the Myeloma Manager™ may become sluggish, or slow to respond when you add or update results. The easy way to solve this problem is to click on the Date Range button on the Results tab.

This will bring up a window that will allow you to specify display of all dates, a specific range of dates, or a specified number of the most recent result dates.
Using this feature doesn't delete the results not shown. They can always be restored by clicking the Date Range button and selecting All.

If you use the Import function to import more than 12 result dates, the date range will automatically be set to display only the most recent 12 results.

Printing A Full Historical Report" (page 20) for further details on how this works.

**Printing All Results For A Specific Date Or Test**

If you highlight any result on the Results tab, you can then press the "Date" button to bring up a window showing all test results for that date.

You can then click on the "Print" button on this window to print all results for the selected date. Similarly, you can print results for a test for all dates by highlighting a single result and clicking on the "Test" button.

**Printing A Graph For A Test**

You can print a graph for a test from the graph preview window (see Previewing And Printing Your Graph, page 5.). You can also print a graph for a single by highlighting any result for that test on the Results tab and clicking the "Graph" button.
<table>
<thead>
<tr>
<th>Lambda FLC (g/L)</th>
<th>K/L Ratio (0.3-1.7)</th>
<th>WBC (3.5-9.1)</th>
<th>HCT (38.8-46.4)</th>
<th>RBC (4.3-5.6)</th>
<th>HGB (13.3-17.7)</th>
<th>PLT (165.1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>▲</td>
<td>4.3</td>
<td>36.4</td>
<td>▼ 4.2</td>
<td>▼ L</td>
<td>▼ 12.5</td>
</tr>
<tr>
<td>6</td>
<td>▼</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>▼ 282.0</td>
</tr>
<tr>
<td>1</td>
<td>▼</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>▲</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>▼</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>▼</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Administration

Using the administration menu, you can:

- Modify your account information
- Set up and change tests and groups
- Set up and change groups
- Set up calculated tests
- Delete test results

Setting Up Groups

You can setup the tests that you will track by selecting the Setup Tests option under the Admin menu.

This will bring up the Setup Tests window. To setup a new group, click the "New Group" button.
This will bring up a template for entering a new group. After you've entered the new group definition, you need to click Save.

**Setting Up Tests**

You can setup the tests that you will track by selecting the Setup Tests option under the Admin menu.
This will bring up the setup tests window. Click on the "New Test" button to bring up a template for entering a new test.

![New Test Window]

The information you need to enter for a new test includes:

- **Group**— the group under which the test will be listed (must be selected from the previously defined groups,)
- **Type**— test results can be numbers, text or a calculation
- **Format**— tests that are of type number or calculation can then be formatted either as a % or a number and the number of digits to display to the right of the decimal point can be specified
- **Range**— the low and high normal ranges for the test

**Setting Up Calculated Tests**

Some results listed on lab reports are calculated values. That means that if you know the results for the tests that they are based on, you do not need to enter the value. An example of this is the FreeLite Kappa/Lambda Ratio. This result can be calculated by dividing the Kappa FreeLite result by the Lambda FreeLite result. The Myeloma Manager™ will calculate results for you automatically if you set the test up as a calculated test. To do this, create the new test as described under "Setting Up Tests." You then specify the test type as "Calculation" and follow the procedure illustrated below:
Importing Data Into The Myeloma Manager™

If you have a lot of data previously saved in a spreadsheet or other electronic form, you can use the Import function to bring this data into the Myeloma Manager™.

In order to import your data, it needs to be in a text file, with each column separated by a tab character (this is one of the options for exporting data from Microsoft Excel.)

The first column is used to identify the data on each line. Each column to the right of the first column can contain another test. The sequence of data required is as follows:

<table>
<thead>
<tr>
<th>Line Number</th>
<th>First Column</th>
<th>Columns 2-n</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>&quot;Group&quot;</td>
<td>Group Name For Test</td>
</tr>
<tr>
<td>2</td>
<td>&quot;Test Short Name&quot;</td>
<td>Short Name For Test</td>
</tr>
<tr>
<td>3</td>
<td>&quot;Test Long Name&quot;</td>
<td>Long Name For Test</td>
</tr>
<tr>
<td>4</td>
<td>&quot;Units&quot;</td>
<td>Units (e.g., g/dl) - Optional</td>
</tr>
<tr>
<td>5</td>
<td>&quot;Low&quot;</td>
<td>Low Normal Range For Test</td>
</tr>
<tr>
<td>6</td>
<td>&quot;High&quot;</td>
<td>High Normal Range For Test</td>
</tr>
<tr>
<td>7 - m</td>
<td>Result Date (e.g., 12/11/07)</td>
<td>Date For Results Contained On This line</td>
</tr>
</tbody>
</table>

Line number 7 can be repeated for each date for which you have results to import. Below is an example of this format.

<table>
<thead>
<tr>
<th>Group Name</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
<th>CBC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Short Name</td>
<td>HGB</td>
<td>HCT</td>
<td>Hematocrit</td>
<td>MCV</td>
<td>MCH</td>
<td>MCHC</td>
<td>PLT</td>
<td>RDW</td>
<td>RDW</td>
<td>MPV</td>
<td>Platelet Volume</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Long Name</td>
<td>g/dl</td>
<td>%</td>
<td>fl</td>
<td>g/dl</td>
<td>%</td>
<td>fl</td>
<td>g/dl</td>
<td>%</td>
<td>fl</td>
<td>g/dl</td>
<td>%</td>
<td>fl</td>
<td>g/dl</td>
</tr>
<tr>
<td>Low Normal</td>
<td>13.3</td>
<td>38.8</td>
<td>79</td>
<td>26.7</td>
<td>32.3</td>
<td>165</td>
<td>11</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High Normal</td>
<td>17.7</td>
<td>46.4</td>
<td>93.4</td>
<td>34</td>
<td>35.9</td>
<td>415</td>
<td>14</td>
<td>12.95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/1/2007</td>
<td>62</td>
<td>461</td>
<td>21</td>
<td>30.8</td>
<td>34.4</td>
<td>308</td>
<td>15</td>
<td>6.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/2/2007</td>
<td>72</td>
<td>454</td>
<td>22</td>
<td>30.2</td>
<td>33.2</td>
<td>287</td>
<td>14.6</td>
<td>5.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/3/2007</td>
<td>80</td>
<td>461</td>
<td>21</td>
<td>30.6</td>
<td>34.4</td>
<td>250</td>
<td>14.3</td>
<td>5.7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/4/2007</td>
<td>88</td>
<td>468</td>
<td>20</td>
<td>31</td>
<td>35.6</td>
<td>213</td>
<td>14</td>
<td>5.6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/5/2007</td>
<td>96</td>
<td>475</td>
<td>19</td>
<td>31.4</td>
<td>36.8</td>
<td>176</td>
<td>13.7</td>
<td>5.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/6/2007</td>
<td>104</td>
<td>482</td>
<td>18</td>
<td>31.8</td>
<td>38</td>
<td>139</td>
<td>13.4</td>
<td>5.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/7/2007</td>
<td>112</td>
<td>489</td>
<td>17</td>
<td>32.2</td>
<td>39.2</td>
<td>102</td>
<td>13.1</td>
<td>5.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/8/2007</td>
<td>120</td>
<td>496</td>
<td>16</td>
<td>32.6</td>
<td>40.4</td>
<td>65</td>
<td>12.8</td>
<td>5.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/9/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/10/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/11/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/12/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/13/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/14/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/15/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/16/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/17/2007</td>
<td>128</td>
<td>503</td>
<td>15</td>
<td>33</td>
<td>41.6</td>
<td>28</td>
<td>12.5</td>
<td>5.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/18/2007</td>
<td>120</td>
<td>496</td>
<td>16</td>
<td>32.6</td>
<td>40.4</td>
<td>65</td>
<td>12.8</td>
<td>5.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/19/2007</td>
<td>120</td>
<td>496</td>
<td>16</td>
<td>32.6</td>
<td>40.4</td>
<td>65</td>
<td>12.8</td>
<td>5.2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In this example (above), there are eight tests being imported for dates ranging from 1/1/2007 to 1/15/2007.

Once you've formatted your input file for the Myeloma Manager™, you would select File Menu/Import/Restore/From External Source to start the import.

This will bring up a window asking you to locate the import file. You press the Browse button to locate the file and then the Start button to begin the import process.

**Backing Up And Restoring Your Data**

You can create a backup of all of your Myeloma Manager™ data and preferences using the File Menu/Export/Backup option.
This will create a file in a directory of your choosing that can be restored on your computer or another computer. To restore a file, use the File Menu Import/Restore option.

Note that the backup is encrypted so that it cannot be read by other programs and the Myeloma Manager™ will not load the backup without the password that was set up by the user who created the data.

**Changing Your Password**

You can change your password or other details of your profile by using the Admin Menu/Modify Account Info option. This will bring up a window that will show you the current values and allow you to make changes.
Deleting Results

If you need to delete all results for a date, you can do that via the admin menu.
This function is not intended for deleting individual results (i.e., one test result for one date.) Individual results can be deleted by selecting the result on the results grid and clicking one of the view/edit buttons.
To delete all results for a given date or multiple dates, follow the procedure illustrated below:

Getting Help

Technical support for the myeloma manager is provided via email or an online bulletin board.

- MMPCA Bulletin Board -- You can access the MMPCA bulletin board by visiting http://mmpca-forum.myeloma.org
- Emailing MMPCA -- You can also email mmpca@myeloma.org

Software Updates and News

The Myeloma Manager™ can automatically check for updates and notify you when a new update is available. You can enable this feature by selecting Options on the Tools menu.
You can then select Update under General (click on the + next to general if you don't see the Update option). The dialog displayed allows you to turn automatic update checking on or off and also to specify how often to check for updates.

We also post software update notices and news about the Myeloma Manager™ on the IMF website. Click here to go to the software updates and news page.

We will also post software update notices and news about the Myeloma Manager™ on the IMF website. Click here to go to the software updates and news page.